
RELEASE NOTES

Release Notes for Katana 2.1v1

Release Date
19 November 2015

System Requirements
• Katana 2.1v1 is tested and qualified on Linux 64-bit CentOS/RHEL 6

• A graphics card which supports OpenGL shadermodel 4.0

• A supported renderer (see below)

Supported Renderers

Pixar’s RenderMan, Solid Angle’s Arnold and Chaos Group’s V-Ray are each supported by plug-ins supplied directly by
those companies.

For Pixar’s RenderMan, please contact Pixar to get RenderMan Studio for Katana (also called RfK). You also need to
install the relevant version of the RenderMan renderer (RenderMan Pro Server).

For Arnold, please contact Solid Angle to get KtoA. This includes both the Arnold renderer as well as the Katana plug-
in.

For V-Ray, please contact Chaos Group to get V-Ray for Katana. This includes the V-Ray renderer as well as the Katana
plug-in.

All queries regarding third-party plug-ins should be directed to the relevant provider.

The Katana installation includes legacy plug-ins for PRMan 17.0 and Arnold 4.2, which should bemainly considered
as reference to show how a render plug-ins can be implemented. For support of the latest renderer versions and
features it is recommended to use the plug-ins provided directly by the relevant vendor company.
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Third-Party Dependencies

Katana 2.1v1 has dependencies on the following third-party libraries:

• OpenEXR 2.0.1

• OpenSSL 1.0.0a

These libraries are provided in the Katana distribution, in separate directories under ${KATANA_HOME}/bin

An ABI-compatible copy of these libraries needs to reside on your LD_LIBRARY_PATH in order formany of Katana's
plug-ins to run. The Katana application itself uses RPATHs to locate the required libraries.

NOTE: Katana's wrapper script ${KATANA_HOME}/katana appends ${LD_LIBRARY_PATH} to ensure these
libraries are visible to Katana plug-ins.
If youmanage your own LD_LIBRARY_PATH orwish to expose these libraries to plug-ins by some other
means, you can call the Katana binary directly using:

   ${KATANA_ROOT}/bin/katanaBin

Feature Enhancements and Important Changes

Working Sets

Two new columns have been added to the Scene Graph tab:

• Viewer Visibility - controls which objects are drawn in theViewer tab

• Render - controls which objects are rendered in interactive renders

Together with the Live Render Updates column, these are referred to asWorking Sets: sets of scene graph locations
with corresponding states.

Traditionally in Katana, theViewer tab was closely linked to the Scene Graph tab. The Viewer displayed locations
that were expanded in the Scene Graph tab, and you could choose a sub-set of objects to be rendered using the
Render Selected Objects Only option. The expansion and selection states were therefore critical to an artist's
workflow.

Themain purpose of Working Sets is to decouple the expansion and selection states of scene graph locations in the
Scene Graph tab fromwhat's being drawn in theViewer tab and fromwhat's being rendered when rendering.
Working Sets are intended to allow artists to inspect a scene in the Scene Graph tab by expanding and collapsing
branches at will, without incurring draw operations in theViewer tab or render updates when Live Rendering. Artists
are to be able to add and remove scene graph locations to and from specific Working Sets, and to use specific
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Working Sets in relevant UI operations. This provides the ability to work with particular locations and branches of a
scene graph withmuchmore flexibility than is afforded by scene graph expansion, pinning, and selection.

For an overview of the new features and workflows, please see theWorking Sets chapter of the Katana User Guide.

Improved Node Graph Tab Navigation

The top of theNode Graph tab has been redesigned to allow formuch easier navigation in large Katana projects. In
addition to the existingUp button that lets you enter the parent node of theGroup nodewhose contents are shown
in aNode Graph tab, we have added Back and Forward buttons to allow you to enter a Group node that has
previously been entered in the same tab. The path of node names next to theUp button has been replaced with an
interactive breadcrumbs bar, in which individual Node Buttons represent all ancestor nodes of the Group node
whose contents are shown. Each Node Button can be clicked to enter the corresponding ancestor Group node. The
toolbar also accepts drag and drop events as navigation commands for both Group nodes (enter) and non-Group
nodes (show).

The newNode Button widget is also used to represent the currently viewed node in the Scene Graph tab, as well as
nodes whose parameters are edited in the Parameters tab.

Node Buttons

Node Buttons show the name of the node they represent, show a view and/or edit icon if the node has its view
and/or edit flags set, and use the color of the node for the button's background.

TheNode Button widget has been designed to mimic theways you can interact with nodes in theNode Graph tab.
With the pointer over a Node Button, the following keyboard shortcuts can be used to make changes to the node
represented by theNode Button:

• The View flag can be set by pressing theV key, thereby showing the scene graph that is produced by the node
in a Scene Graph tab.

• The Edit flag can be set by pressing the E key, thereby showing the parameters of the node in a Parameters
tab.

• The View flag can be toggled by pressing Shift+V.

• The Edit flag can be toggled by pressing Shift+E.

• The bypassed state can be toggled by pressing theD key.

• The same context menu that can be opened for a node in theNode Graph tab can be opened by right-clicking
a Node Button.

• A representation of the underlying node can bemiddle-click dragged from aNode Button to any UI
component that accepts dragged nodes.

In addition to the above, Node Buttons provide the following functionality:

• When clicking a Node Button, the name of the node becomes editable, either inside theNode Button itself, or
in a dialog for editing the value of a parameter that drives the name of the node. Clicking Node Buttons in the
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new breadcrumbs bar of theNode Graph tab does not rename the corresponding nodes, but rather enters
the clicked Group node, as before.

• Nodes can also be renamed by pressing theReturn, Enter, or F2 key when the pointer is placed over a Node
Button.

• When holding theCtrl key while clicking a Node Button, the corresponding node is revealed and selected in the
Node Graph tab.

• Node Buttons that represent disabled nodes are drawn with dimmed background and text colors, and with a
slightly larger disabled icon.

Improved Parameters Tab Headers
• BUG ID 50056 - The headers of parameters that are edited in the Parameters tab have been re-designed to make
use of the newNode Button widgets, offering a consistent appearance and behavior across theUI.

The following list describes the changes to the parameter header widgets in detail:

• The node name text edit widget has been replaced with a Node Button in between the disclosure
triangle and the node type name. The node name in theNode Button appears with a bold font
weight. The node type namenow appears with a normal font weight instead of a bold font weight.

• The node drag icon next to the node type namehas been removed.
In order to drag a nodewhose parameters are edited in the Parameters tab, you can now drag the
Node Button with themiddlemouse button, just like you can in other tabs that useNode Buttons.

• The separate disabled icon has been removed from the parameters header, as the disabled state of a
node is already reflected in theNode Button that represents the respective node.

• While the pointer is over a parameters header, theD key can no longer be pressed to disable the
corresponding node. That behavior is part of theNode Button itself, just like how theD key works for
nodes in theNode Graph tab.

• The toolbar buttons in the header have beenmoved to the right of the header. As part of this, the
Edit Node button has beenmoved to the very right, next to the Find Parameters button. These
changes apply to the Project Settings tab as well.

• The tiny help button next to the disclosure triangle of a header has been replaced with a standard
toolbar button in the toolbar of a header, which ismuch easier to click, and which provides a tooltip
indicating what kind of help is available. That help toolbar button opens amuch wider help pop-up
than the one opened by the previous help button.

'Click lock' for Drag-and-Drop
• BUG ID 44728 - Drag-and-Drop of UI items can now be performed without a sustainedmouse press by using the
new ‘click lock’ feature: hover the pointer on the source item, press Ctrl+B to grab, move to the target widget and
either click any button or press Ctrl+B to drop.
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NOTE: TheCtrl+B keyboard shortcut has been selected based on availability across Katana’s UI and
international keyboard layouts. If you use this feature on a regular basis, youmay want to use a custom
mapping to this key combination.

‘Sticky Scrubbing’
• BUG ID 44729 - It is now possible to scrub numeric parameters without a sustainedmouse press by turning on the
stickyScrub preference. When turned on, clicking a parameter label starts the sticky scrubbing and clicking again
stops and sets the value. As with normal scrubbing, the Esc key cancels an ongoing scrub.

Miscellaneous
• All Attribute object methods and utility functions in OpScript are now documented.

• BUG ID 35747 - The Toggle Ignore State of Selected Nodes command in the Editmenu of theNode Graph
tab has been renamed to Toggle Disabled State of Selected Nodes.

The context menus of lists of child nodes of GroupStack andMaterialStack nodes have been revised for clarity and
consistency with similarmenus.

The names of some undo entries have been revised for clarity and consistency.

• BUG ID 38677/50254 - The disabled state of any node can now be controlled by a number parameter named
disable added to that node.

Setting thedisable parameter to 1 or 0 disables or enables the node, respectively.

• BUG ID 39273 - Region of Interest (ROI) is now defined relative to resolution, rather than as absolute pixel values.
This improves consistency between renders with different resolutions. In existing projects this conversion to
relative coordinates only occurs if you change the ROI.

• BUG ID 41397 - Renderer plug-ins now receive updates to the Region of Interest (ROI) On/Off state during a Live
Rendering session.

• BUG ID 42759 - TheViewer tab’s activity indicator is now active during both Viewer geometry processing and
global scene graph processing.

• BUG ID 44201 - A new Rotate Around COI (world) viewermanipulator has been introduced, allowing rotation of
a light or camera around its Center of Interest (COI) in world space.

• BUG ID 44376 -When viewing through the perspective camera in theViewer tab, and pressing theX, Y, or Z key or
clicking one of the axes in theHUD, the view in theViewerwas unexpectedly zoomed.

Now, doing the same orients the perspective camera along the equivalent axis, keeping the camera target framed.
Pressing the Shiftmodifier key, while pressing one of the above keys, places the camera in the negative direction of
the chosen axis. The above operations no longer change the camera to an orthographic projection (see related
feature 50992).

• BUG ID 47191 - TheDisplay Visualizationmenu of theMonitor tab has beenmodified to show the names of
color spaces that correspond to the listed views in parentheses on the right of themenu.
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It is also now possible to specify a "neutral" colorspace for color parameters, with theKATANA_OCIO_NO_
FILMLOOK_COLORSPACE environment variable. This neutral colorspace is applied when the film look is not
applied. Color parameters canmake use of this with the color_enableNoFilmlookColorSpace hint.

• BUG ID 47852 - New API functions in theKeyboardShortcutManagermodule allow you to interrogate
information about registered keyboard shortcuts.
The new functions areGetFullActionName(actionID), which returns the full name of an action given the unique
action ID andGetShortcutForAction(actionNameOrID), which returns a string representing the registered
shortcut for the given action name or ID.

• BUG ID 47942 - The FarmAPI.GetSortedDependencyList()method has been deprecated and is to be removed
in a future release. Thismethod has been replaced with FarmAPI.GetSortedDependencies(), which returns a list
of FarmAPI.NodeRenderSettings instances.

• BUG ID 48324 - TheViewer tab now has aWorking Set context menu, whichmay be extended with custom items
by use of a callback:

viewerTab = UI4.App.Tabs.FindTopTab('Viewer')
if viewerTab:
    viewerTab.setContextMenuEventCallback(callback)

• BUG ID 49054 - Pressing theA key while hovering a location parameter widget (such as isolateLocations in an
Isolate node ormaterialAssign in aMaterialAssign node) now adds the currently selected location(s) to it.

• BUG ID 49543 - The default value of the inputBehavior parameter of OpScript and GenericOp nodes has been
changed from only valid to by index. Theby index behaviormatches the treatment of unconnected input ports
in Switch nodes.

• BUG ID 49593 - The contents of a non-editable LiveGroup node are now cleared when the node is disabled. If such
a LiveGroup node is enabled ormade editable, its contents are loaded from the respective source. The clearing of
disabled LiveGroup nodes can dramatically reduce the number of nodes in amulti-shot/multi-department project.

• BUG ID 50014, 21888, 21889, and 22630 - The appearance of toolbar buttons across theUI has been refined.

Notable changes include:

• Highlighted versions of icons have been added, as well as tooltips to many more toolbar buttons
where they weremissing.

• Some icons have been revised to be easier to read, notably the gear, wrench, andmagnifying glass
icons.

• Pane buttons have been revised:

• Moved theMaximize Pane/Restore Pane button from the left-hand side to the right-
hand side, and replaced the +/- icons used for themwithmaximize/restore icons.

• Added tooltips to clarify meaning of buttons.

• The icon color of Trigger 3D Update buttons has been changed fromwhite to red when there is an
update to parameters of nodes that has not triggered a scene cook. These buttons become enabled
when the 3D Update Mode is set toManual.

RELEASE NOTES FOR KATANA 2.1V1 | FEATURE ENHANCEMENTS AND IMPORTANT CHANGES



RELEASE NOTES 7

• Buttons in help pop-ups have been revised to be easier to click, and tooltips have been added to
clarify theirmeaning.

• The icon of the Live Render Updates column in the Scene Graph tab has been revised to indicate
that it's always active and cannot be turned on or off.

• Layouts of the Included Outputs pop-up for Render nodes in the Parameters tab, as well as the
Available Lights pop-up of the Lights column in the Scene Graph tab, have been revised to be
consistent.

• BUG ID 50021 - The initialiseCaches()method in the RendererInfoPlugin API is deprecated and is no longer
called.

• BUG ID 50980 - You can now press theM key in theNode Graph tab to merge selected nodes. The equivalent
menu command is Edit >Merge Selected Nodes.

• BUG ID 50992 - You can now press theC key in theViewer tab while looking through the perspective camera to
toggle that camera between perspective and orthographic projections, while keeping the current target framed.

• BUG ID 51108 - The scenegraph/findLocationsFilterDefault preference has been added to specify the default
filter used in the Find Locations popup of the Scene Graph tab, which can be opened by clicking themagnifying
glass toolbar button or pressing Ctrl+F.

• BUG ID 51235 - The Tabs > Nodemenu now contains GafferThree by default, instead of Gaffer, as one of the
node type-specific tab types to choose from.

Bug Fixes
• BUG ID 29044 - Pasting a nodewhile dragging a port connection arrow resulted in errors.

• BUG ID 33802 - Docking a floating pane after closing a tabbedmenu bar within the pane caused Katana to crash.

• BUG ID 42551 - Pressing the Y key over theNode Graph tab to align selected nodes, with no nodes selected,
raised an exception.

• BUG ID 46096 - Upper-case characters could not be used for tags that were provided for shader parameters, such
as when using Args files.

Attempting to connect shading node ports tagged with values containing upper-case characters raised a Python
exception.

• BUG ID 47088 - Connecting a Switch or Dot node to an input port of a NetworkMaterial node raised an exception.

• BUG ID 48558 - Using an orient constraint with fewer than three axes constrained could produce unexpected
results with target angles greater than 90 degrees.

• BUG ID 49025 - Package reparenting operations that had been disallowed using the PackageSuperToolAPI's
canBeAdoptedBy() were incorrectly allowed and caused an exception.

• BUG ID 49855 - TheRenderManager.IsSceneGraphMaskEnabled() function is deprecated. Please use
Nodes3DAPI.ScenegraphMask.GetScenegraphMaskEnabled() instead.

• BUG ID 49984 -When choosing theWide editor... command in the context menu of a parameter in the
Parameters tab, text of a string parameter or the value of a number parameter was not selected in the dialog.
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• BUG ID 50279 - The Show in Scene Graph option from the Viewer context menu only set SceneGraph focus for
newly-populated locations.

A new scrollToLocations() API function on the Scene Graph tab ensures that given locations are expanded, and
scrolls thewidget so that they're visible.

• BUG ID 50488 - ProcessManager errormessages did not contain the name of the Python script file that was
executed.
These Python script file names are now included, which can help in tracking down issues.

• BUG ID 50575 - Katanawas attempting to autosave too frequently during batch processing, and did not always
save a crash file every time that the UI indicated it was autosaving.

Katana now avoids autosaving during batch processing, and completes a save every time that it indicates that it is
attempting to do so.

• BUG ID 50595 - Katana failed to start if an incompatible renderer plug-in was found in a $KATANA_RESOURCES
directory.

• BUG ID 50669 - TheKeyboardShortcutManagerMixin.registerKeyboardShortcut() function for registering a
keyboard shortcut for a specific type of widget did not support keys on the numerical keypad.

• BUG ID 50990 - Displayingmore than one pane in theViewer tab could result in incorrect panning speed of look-
throughmanipulation.

• BUG ID 50991 - The transform values of lights and cameras created with LightCreate and CameraCreate nodes, and
of locations edited through TransformEdit nodes, could not be scrubbed in theViewer tab'sQuick Editor.

• BUG ID 51200 - The resolver for constraints attempted to operate onmissing targets even when constraints were
configured to allowmissing targets (such as when using the allowMissingTargets parameter of constraint
nodes), consequently producing errormessages or incorrect results.

• BUG ID 51685 - Changes to SceneGraphViewwidget terminal Op arguments could be lost on changing column
configuration.

Known Issues
• BUG ID 51489 -With selection syncing turned on in the Parameters tab for a GafferThree nodewhose
parameters are being edited, additional parameter views (such as when showing parameters of the same node in a
floating pane) do not allow the selection of items to be changed.

• BUG ID 50911 -When changing an array parameter's tuple count/size, any corresponding attributes are not
properly updated in theAttributes tab.

• BUG ID 49625 - Shading node output ports with names other than out are duplicated on flushing caches.

• BUG ID 49051- The Viewermay lose sync with the Scene Graph tab when changes to expansion state are
interrupted.

• BUG ID 47853 - Indication of attribute source nodes, such as the yellow glow in theNode Graph tab, is not yet
implemented in Katana 2.x.

• BUG ID 44318 - Arnold Live Rendering: Lights created, enabled, or renamed during a Live Render sessionmay not
affect that session.
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• BUG ID 43072- PRMan Live Rendering: The adjustScreenWindow parameter in the RenderSettings node is not
taken into account for cameras other than the one specified in the RenderSettings node.

• BUG ID 41152 -When editing parameters of a node that is part of a LiveGroup node and reloading the parent
LiveGroup node, the UI state of the Parameters tab is reset. This includes scroll bar positions, selections of items,
and selections of nested tabs (for exampleObject,Material, and Linking tabs for a Gaffer node).

• BUG ID 41092 -When reloading a LiveGroup node's parameter interface and contents from its source, parameters
of child nodes that are edited in floating panes disappear from those panes.

• BUG ID 40709 - The Alembic library does not support multiple processes or thread access to an Alembic file. This
means that a crash occurs whenmodifying an Alembic file outside Katana, while it's loaded in an open Katana
scene. To avoid this, youmust Flush Caches before attempting to update any modified Alembic files.

• BUG ID 40600 - Undoing a revert of an unpublished LiveGroup node does not restore the LiveGroup's editable
andmodified state.

• BUG ID 40599 - The user parameters of non-editable LiveGroup nodes can incorrectly be edited.

• BUG ID 40598 - Reverting a LiveGroup node does not revert its user parameters.

• BUG ID 40237 - Nodes can be dragged into theGroup bubble of a non-editable LiveGroup node.

• BUG ID 39261 - The operations that lock and unlock nodes do not currently create entries in theUndo History,
which can lead to an incorrect node graph statewhen undoing and redoing operations.

• BUG ID 36926 - The rendererSettings > displayOptions parameter of a RenderOutputDefine node for the
PRMan renderer, shown when its type parameter is set to raw, cannot be set using the Parameters tab.

For a workaround, the UpdatePrmanSettingNodes shelf script can be used. The script, available in the PRMan 17
shelf, creates an AttributeScript node that converts display options, set using string attributes, to group attributes.

• BUG ID 36691 - State badges are currently shown for attribute values of dynamic array child parameters, even
though only their parent array parameter should appear with a state badge.

• BUG ID 36663 - It is not currently possible to sort notifications in theNotifications pop-up window.

• BUG ID 36225 - TheUpdatePrmanSettingsNode shelf script does not currently deal with expression
parameters.The locally set parameter expressions on PRMan nodes need re-adjusting after running the shelf script.

• BUG ID 36176 - The 2D nodeDisk Render Upstream Render Outputs option does not use the batch render
method, batchRender, for upstream render nodes, instead using diskRender.

• BUG ID 36170 - The control keys (notably arrow keys) do not function as expected in shell mode.

• BUG ID 34949 - Using Compiz can lead to text fields not receiving focus events correctly due to an incompatibility
between Compiz and QT. Depending on your configuration, disabling Compiz desktop effectsmay resolve the
problem.

• BUG ID 34870 - Katana doesn't support render output directory creation for shadow,merge, and script output
types.

• BUG ID 33242 - Live Rendering is not designed to work with rapid updates to region of interest (ROI), andmay
cause unexpected behavior.

• BUG ID 31790 - In the Parameters tab, setting an expression for an array or a group parameter currently breaks
the parameter's UI.
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• BUG ID 28549 - Themainmenu commands that create nodes, notably File > Import..., File > Import
LiveGroup..., andHelp > I want a pony, do not create the nodes in a Group or LiveGroup node that has been
entered in aNode Graph tab, instead they create the nodes in the root level of the node graph document.

• BUG ID 22296 - Live Rendering with AOVs is not supported with PRMan 17 and earlier due to a known issue in
these versions of the renderer.

For a workaround, to allow Live Rendering, disable AOVs in interactive renders by applying an Interactive Render
Filter, using a RenderSettings nodewith the interactiveOutputs parameter set to just primary.
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